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Abstract

Subretinal injections have been successfully used in both humans and rodents to deliver therapeutic interventions of proteins, viral agents, and
cells to the interphotoreceptor/subretinal compartment that has direct exposure to photoreceptors and the retinal pigment epithelium (RPE).
Subretinal injections of plasminogen as well as recent preclinical and clinical trials have demonstrated safety and/or efficacy of delivering viral
vectors and stem cells to individuals with advanced retinal disease. Mouse models of retinal disease, particularly hereditary retinal dystrophies,
are essential for testing these therapies. The most common injection procedure in rodents is to use small transcorneal or transcleral incisions
with an anterior approach to the retina. With this approach, the injection needle penetrates the neurosensory retina disrupting the underlying
RPE and on insertion can easily nick the lens, causing lens opacification and impairment of noninvasive imaging. Accessing the subretinal space
via a transcleral, posterior approach avoids these problems: the needle crosses the sclera approximately 0.5 mm from the optic nerve, without
retinal penetration and avoids disrupting the vitreous. Collateral damage is limited to that associated with the focal sclerotomy and the effects of
a transient, serous retinal detachment. The simplicity of the method minimizes ocular injury, ensures rapid retinal reattachment and recovery, and
has a low failure rate. The minimal damage to the retina and RPE allows for clear assessment of the efficacy and direct effects of the therapeutic
agents themselves. This manuscript describes a novel subretinal injection technique that can be used to target viral vectors, pharmacological
agents, stem cells or induced pluripotent stem (iPS) cells to the subretinal space in mice with high efficacy, minimal damage, and fast recovery.

Video Link

The video component of this article can be found at http://www.jove.com/video/54808/

Introduction

Subretinal injections are the primary means of delivering cellular and viral agents to the retinas of mice to study their effects on photoreceptors
and the underlying RPE1,2. Most subretinal injection protocols in mice use a transcorneal or a transcleral injection site anterior to the equator
(Figure 1). This approach can result in inherent collateral damage that includes nicking and resultant clouding of the lens, disruption of the
integrity of the vitreous, penetration of the neurosensory retina and iris, retinal hemorrhage, substantial retinal detachments and lasting subretinal
edema 3-9. Experimental manipulations must overcome these effects in order to evaluate the effects of therapeutic interventions3,7,10,11. This
study provides a detailed description and validation of a posterior transcleral injection method that avoids these complications, minimizes trauma
and has a high success rate of targeting the subretinal space.

Injections targeting the subretinal space in mice are often very difficult to perform and most investigators encounter a high frequency of
failed attempts in which the vector is delivered to an incorrect location or there is significant retinal damage, for example in a complete retinal
detachment6. The number of eyes excluded from analysis because of injection complications is typically not reported in mouse studies, but in
our own experience and in discussion with other investigators, the number of failed injections can be as high as 50% and vary dependent on
the experience and capabilities of the investigator who is performing the injections. The success of the injection is typically assessed by direct
fundus imaging and/or optical coherence tomography (OCT)7,9. An easily mastered method with high success rates for subretinal injections in
mice can hasten experimentation and reduce the cost of preclinical studies of treatments for retinal diseases that are major causes of blindness
in the United States.

The posterior, transcleral subretinal injection technique described here is an adaptation from clinical and preclinical protocols9,12. The
noninvasive diagnostic assessments performed in injected mice demonstrate mild and highly localized damage and lack additional collateral
lens, retinal and RPE injury. Furthermore, with relatively little practice, an experimenter can achieve these results with a high success rate (80 -
90% or better), thereby reducing the costs associated with such studies. This procedure can be used to deliver cellular, viral, or pharmacological
therapeutic interventions to photoreceptors and/or RPE in preclinical studies and to easily evaluate experimental interventions.
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Protocol

Animals: Wild type C57Bl/6J mice bred at the University of California at Los Angeles (UCLA). All animals were between 11 - 17 weeks old, and
included male and female mice. All mice were group-housed, maintained in a 12:12 light/dark cycle with food and water ad libitum. All experiments
were performed in accordance with the institutional guidelines of UCLA and the Association for Research in Vision and Ophthalmology Statement
for the Use of Animals in Ophthalmic and Vision Research.

NOTE: All drugs and injectable agents are United States Pharmacopeia (USP) grade.

1. Surgical Preparation

1. Anesthetize the mouse with an intraperitoneal injection of 100 mg/kg ketamine and 8 mg/kg xylazine in a saline mix. Administer anesthesia to
a depth such that the mouse has no toe pinch or corneal touch reflexes.

2. Maintain body temperature at 37.0 °C with a circulating water pad.
3. Dilate pupils with 2.5% phenylephrine eye drops and trim whiskers to facilitate visualization. Whiskers provide significant sensory input to the

mouse, therefore, whisker trimming should remove only the portion that blocks clear access to the eye, and not to the base of the whisker. In
our experience, mice show normal recovery after this procedure. Apply methylcellulose eye drops to prevent dryness and minimize anesthetic
induced transient cataracts13.

4. Sterilize instruments prior to surgery (i.e., betadine and ethanol or hot beads).
5. Prepare diluted fluorescein (0.01% using 0.9% saline) in a sterile environment (i.e., biosafety cabinet) if visualization will be performed (see

section 3 below).

2. Injection Site Preparation

1. Prepare a syringe (e.g., 5 µl syringe) with the appropriate injection volume (e.g., 0.3 to 1.0 µl).
2. Position the mouse so the eye is facing up and clearly visible in the dissecting microscope.
3. Gently pinch the temporal conjunctiva with fine tipped forceps. Make a circumferential incision of approximately 90 degrees using curved

Vannas scissors.
4. Repeat step 2.3 with the underlying Tenon's capsule.
5. Resect the surrounding connective tissue with fine tipped forceps while rotating the globe nasally. Work towards the injection site

approximately 0.5 mm temporal to the optic nerve. Use great care to avoid disrupting the retro-orbital sinus.

3. Sclerotomy and Subretinal Injection

NOTE: It is recommended that the injection of 0.01% fluorescein in 0.9% Saline be used to assist with visualization while learning this procedure.
The topographic distribution of fluorescein can be effectively documented with fundus imaging (see section 4 below).

1. Make a small scleral incision at the injection site by gently scratching the eyecup with a 22.5-degree ophthalmic blade. This incision should
only be large enough to allow the tip of the needle to pass through the sclera.

2. Insert the beveled 33 G needle (angled 5 - 10° into the sclerotomy with the bevel facing and angled parallel to the retina. Inject desired
volume (e.g., 0.3 to 1.0 µl of 0.01% Fluorescein for learning purposes).
 

NOTE: Maintain sterility of the syringe by thoroughly cleaning with successive washes of a suitable solvent and DI water before each
injection.

3. Depress the plunger slowly (over ~ 3 sec) without moving the needle and with even pressure.
 

NOTE: When the needle is in the subretinal space, a slight resistance will be felt while depressing the plunger. There will be no to minimal
resistance if the needle punctures the retina, and high resistance if the needle does not penetrate the sclera or RPE.

4. Wait several seconds before withdrawing the needle to minimize backflow.
5. Rinse the eye with sterile buffered saline and ensure the eye has rotated back to its normal position.

4. Assessment of Retinal Detachment by OCT and Fundus Imaging

1. Perform OCT imaging immediately after injection to evaluate the quality of the injection and at appropriate time points post-injection as
needed to evaluate retinal structure.
 

NOTE: Examples of the use of OCT in similar studies has been previously described7,14.
1. Adjust and align the OCT image to target the site of injection. The injection site should be midline and 0.5 mm temporal to the optic

nerve head. Repeat as needed if the detachment is out of frame or not optimally centered.

2. Visualize retinal detachment and dye injection area with en-face fundus imaging7,14.
 

NOTE: If an OCT imaging system is not available, injection of a small amount of fluorescein with a vector for practice will allow visualization
with any fundus camera that performs fluorescein angiography using the same excitation wavelengths and blocking filters. Localized areas of
hyper-fluorescence will appear underneath the vasculature and the vasculature will have sharp and distinct boundaries if the subretinal space
is targeted correctly. The edge of the bleb from the injection will be demarcated by the transition from hyper- to hypo- fluorescence. Several
instruments provide this capability for the mouse; the instrumentation used here is described elsewhere14.

http://www.jove.com
http://www.jove.com
http://www.jove.com


Journal of Visualized Experiments www.jove.com

Copyright © 2016  Journal of Visualized Experiments December 2016 |  118  | e54808 | Page 3 of 10

5. Post-operative Care

1. Apply a thick coat of triple antibiotic ophthalmic cream to the corneal surface of the injected eye.
2. Place mice in clean solitary cages for recovery. Do not combine mice that have undergone surgery until they are fully recovered.
3. Monitor respiration and temperature during anesthesia recovery. Monitor animals until they can maintain sternal recumbency.
4. Perform additional appropriate post-operative monitoring and treatment, including a sub-cutaneous injection of carprofen (5 mg/kg) for post-

surgical pain management.

6. Assessment of Retinal Function by Electroretinography (ERG)

1. Perform ERG analysis pre-injection and at appropriate times post-injection as needed to evaluate retinal function. If the injection was made
into the subretinal space, the retinal detachment should resolve within 72 hr.

1. Use standard ERG techniques to evaluate retinal function before and after injection as previously described14,15.

7. 3D Reconstruction and Bleb Volume Quantification

NOTE: OCT scans with high contrast encompassing the entire detachment within the frame of view are optimal for use. ImageJ/Fiji17,18 and Imaris
were used, but other software can be used.

1. Export the b-scan of interest, import to ImageJ/Fiji and crop (Image > Crop) the portion of the OCT scan to be modeled using the rectangular
selection tool.

1. Adjust contrast (Image > Adjust > Brightness/Contrast) and delineate any missing boundaries by connecting two sections with a line.
2. Draw a straight line with the line tool (holding shift) that spans the RPE to the photoreceptor layer. Measure (Analyze > Measure) the

length of the line to obtain size of maximum detachment for step 7.8.

2. Import cropped frames to the 3D-reconstruction software (See Table of Materials) using the "RGB to Gray" plugin and MATLAB Compiler
Runtime.

3. Set the voxel size (under Image Properties) using the calibration parameters from the OCT scan (x,y,z).
4. Execute the "RGB to Gray" plugin (under Image Properties), with equal weighting to each channel, to create a fourth channel. Delete original

Red-Green-Blue channels.
5. Invert the gray channel using contrast change. Store Image.
6. Click the "add a new surface" button in the 3D-View tab, and begin the guided 4 step process of creating the surface.

1. Set the surface level detail (step 1 of 4).
 

NOTE: In our experience 8.0 to 12.0 was the most effective range.
2. Set the maximum sphere size (under Background Selection) to slightly less than the maximum detachment size measured in 7.1.2.

Create the surface and undo gray channel inversion (step 2 of 4).
3. Set the threshold to the maximum value so the surface of the negative spaces outside of the retina and the detachment do not come in

contact (step 3 of 4).
4. Set the filter type to the number of voxels and isolate the negative space in the detachment site by size. Finish the surface (step 4 of 4).

 

NOTE: The volume of the detachment surface is located under volume in the statistics tab.

Representative Results

Posterior approach transcleral subretinal injections were performed on 31 healthy eyes from 16 wild type mice with injections of 0.3 µl (n
= 18), 0.5 µl (n = 8) and 1.0 µl (n = 5) of 0.01% fluorescein. One eye was excluded from injection due to a pre-existing corneal opacity that
prevented structural and functional analysis. Every injected eye is included in this report. No unintended retinal detachments, punctures of the
neurosensory retina, or leakage into the vitreous were detected nor was any evidence of lens nicking, inflammatory responses, uveitis, or post-
surgical infections in any eyes observed.

Retinal structure was assessed pre-injection, 10 min post-injection and 4 weeks post-injection using OCT imaging (Figures 2 and 3). A 9-point
grid, with the center point overlying the center of maximal detachment, was placed on the 10-min post-injection en face scan (Figure 2B). Using
vascular landmarks, pre-injection and 4-week post-injection scans were rotated to be in registration with the 10-minute post-injection scan. This
allowed identification of exactly the same locations in pre- and post- injection retinal scans (Figure 2A, C).

Subretinal injections resulted in bleb formation that was centered away from the injection site where the needle entered the subretinal space
(Figure 2B arrow), and were either flat (Figure 3A) with a shallow detachment stretching over an extended area or domed (Figure 3B - D) with
deep detachment in a constrained area (Table 1). A domed bleb was defined as any detachment that exceeded 50 µm orthogonal to the RPE.
No rosettes, a wavy pattern produced by stretching of the outer retinal layers, were observed. The extent of injection deposition was visualized
with en face OCT (Figure 2D, dashed line), fluorescein fundus imaging (Figure 2E) and OCT B-Scans (Figure 3). The majority of blebs (29 of
31) extended beyond the field of view of the OCT scans, which encompass approximately 10% of the mouse retina. There was no control over
bleb shape other than increased frequency of domed blebs with greater injection volumes (Table 1). All blebs resolved by 2 weeks (data not
shown).
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Total retinal thickness (Bruch's membrane to the nerve fiber layer) was quantitatively assessed 4 weeks after injection for 0.3 µl (Figure 3A),
0.5 µl (Figure 3B) and 1.0 µl (Figure 3C) injection volumes at each point on the grid present in corresponding b-Scans (Table 1). The percent
difference (%Δ) was calculated as the difference relative to the pre-injection measurements for both structural and functional metrics. Not all grid
points were acquired during all imaging sessions. For example, 3 eyes had 1 or 2 points, 4 eyes had 3 or 4 points, and 23 eyes had 5 to 9 points
in all scans. Domed and flat blebs, and injection volumes were collapsed since total retinal thickness was not significantly different for pre- and
post-injections, although an overall trend towards retinal thinning was observed for both (Table 2).

Further analysis showed small but statistically significant thinning of 6.5% ± 1.9 overall (pre = 196 ± 1, n = 31; post = 183 ± 4, n = 31, T60 = 3.4, p
= 0.001) (Table 3). To determine where retinal thinning occurred, a subset of 10 eyes that contained thickness measurements for all 9 grid points
was analyzed. Similar to the analysis for all eyes, the subset of eyes also showed small but significant overall retinal thinning (10.3% ± 3.5, pre
= 199 ± 1, n = 10; post = 179 ± 8, n =10, T18 = 2.4, p = 0.02). No retinal thinning was observed at sites distal to the injection site (7.2% ± 4.0, pre
= 199 ± 2, n = 10; post = 185 ± 8, n = 10, T18 = 1.7, p = 11). Retinal thinning was observed at the site of maximal retinal detachment (11.2% ±
5.0, pre = 201 ± 2, n = 10; post = 179 ± 10, n = 10, T18 = 2.1, p = 0.04), the injection site without damage (13.8 ± 6.0, pre = 201 ± 1, n = 4; post
= 173 ± 10, n = 4, T6 = 2.8, p = 0.03), injection sites with retinal incarceration when a small region of the retina is pulled through the sclera upon
needle withdrawal (14.1% ± 1.0, pre = 199 ± 1, n = 3; post = 171 ± 3, n = 3, T4 = 8.9, p = 0.001) and injection sites with scarring (26.5% ± 1.6,
pre = 200 ± 3, n = 3; post = 147 ± 10, n = 3, T4 = 5.1, p = 0.007). In total, incarcerations occurred in 14 out of 31 injections, 3 of which resulted in
scar formation of the choroid with loss of up to half of the outer retinal layers (Figure 3E). In each instance, however, these were highly localized
effects.

Full-field electroretinography was performed prior to injection and repeated 4 weeks after injection with relative changes assessed individually for
each eye to assess functional alterations (Table 1). Only dark-adapted and rod-mediated responses were recorded. Intensity response functions
were fitted with Michaelis-Menten equations to derive Vmax for both photoreceptors (a-waves) and the middle retina (b-waves). Responses
were not affected by bleb shape and were therefore collapsed (Table 4). There was a small but statistically significant decrease in Vmax on a-
waves (F(1, 28) = 7.1, p = 0.013) but not b-waves (F(1, 28) = 4.0, p = 0.055) after injection (Table 4). Representative waveforms for pre- and
post-injection of 0.3 µl, 0.5 µl and 1.0 µl are shown (Figure 4). There was an effect of injection volume on both a- and b-waves (F(2, 28) = 6.2, p
= 0.006 and F(2, 28) = 8.8, p = 0.001, respectively).

Lastly, 3D modeling was used to visualize the structure of both domed and flat blebs. An example of a domed bleb (Figure 5A) shows a domed
fluid-filled detachment contained within the scan area. Examples from flat blebs (Figure 5B, C) show shallow fluid-filled areas that extend
beyond the region of the scan. When retinal incarceration occurs, a small hole in the reconstruction is seen (Figure 5C). Artificial boundaries
are shown at the edge of a scan to allow the reconstruction (Figure 5C). Calculation of bleb volumes from these sample injections indicated
that a minimum of 0.15 µl and 0.01 µl was successfully targeted to the subretinal space for 0.3 µl injections resulting in domed and flat blebs,
respectively. The calculated volume injected likely underestimates the actual volume due to resolution of imaging and reconstruction, resorption
of fluid during the procedure as occurs in human subretinal injections, and for flat or domed blebs particularly, if the entire detachment was not
represented in the OCT scans.
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Table 1. Functional and Structural Effects of Subretinal Injections by Eye. Metrics of individual eyes and their outcomes from subretinal
injections. Retinal responses to light (middle retina b-waves and photoreceptor a-waves) and retinal thickness measurements (Bruch's
membrane to nerve fiber layer) are given. Footnotes:
 aBT = Bleb Type, Flat (F) or Domed (D)
 b#gp = number of grid points measured
 

* Eyes used for reconstruction of injection volume.
 

** Only 1 grid point available for measurement at scar.
 

# Eyes with scar formation.

Domed Bleb Flat Bleb 0.3 µl 0.5 µl 1.0 µlTime

(µm) (µm) (µm) (µm) (µm)

Pre-injection 194 ± 2 197 ± 3 195 ± 1 197 ± 1 197 ± 3

Post-injection  176 ± 8 188 ± 3 180 ± 6 184 ± 5 192 ± 5

Table 2. Effect of Subretinal Injections on Total Retinal Thickness. Analysis of bleb shape and injection volume on retinal thickness.
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Thickness (µm)

Site n (eyes) Pre 4 wk Δ %Δ

Retina (all concordant
points)

31 196 ± 1 183 ± 4 -13 ± 4 -6.5 ± 1.9

Retina with all 9 grid
points*

10 199 ± 1 179 ± 8 -20 ± 7 -10.3 ± 3.5

Distal to Injection* 10 199 ± 2 185 ± 8 -14 ± 7 -7.2 ± 4.0

Maximal Detachment* 10 201 ± 2 179 ± 10 -22 ± 9 -11.2 ± 5.0

Injection without
Damage*

4 201 ± 1 173 ± 10 -28 ± 12 -13.8 ± 6.0

Incarceration at
Injection*

3 199 ± 1 171 ± 3 -28 ± 2 -14.1 ± 1.0

Scar at Injection* 3 201 ± 3 147 ± 10 -53 ± 10 -26.5 ± 1.6

Table 3. Effect of Damage on Retinal Structure. Analysis of site-dependent retinal thinning. Footnotes: *Analysis from 10 mice with data from
all 9 grid points.

Vmax (µV) Domed (n=12) Flat (n=6) 0.3 µl (n=18) 0.5 µl (n=8) 1.0 µl (n=5)

a-waves

Pre-injection -338 ± 13 -351 ± 13 -347 ± 9 -334 ± 16 -425 ± 15 

Post-injection -311 ± 8 -321 ± 16 -318 ± 11 -318 ± 18 -355 ± 29

b-waves

Pre-injection 604 ± 30 578 ± 11 595±20 542±26 708±21 

Post-injection 537 ± 35 551 ± 15 542±24 538±31 612±45

Table 4. Effect of Subretinal Injections on Scotopic Rod-mediated a- and b-waves. Analysis of bleb shape and injection volume on retinal
responses to light (middle retina b-waves and photoreceptor a-waves).

 

Figure 1. Schematic Representation of Subretinal Injection. A top-down schematic of a mouse eye in the socket shows the approach in
traditional subretinal injections, using a transcorneal (arrow a) or transcleral (arrow b) injection site near the pars plana. This method uses a
transcleral approach near the posterior pole (arrow c), achieved by rotating the eye nasally to expose the posterior pole. Please click here to
view a larger version of this figure.
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Figure 2. Registration of OCT Images Allows Identification of Retinal Sites for Thickness Analysis. A-C, en face OCT image of mouse
1OS in original orientation. A) Image of retina pre-injection with fused registration grid. B) Image of retina 10 min post-injection. A 9-point grid
was positioned with the center point at the site of maximal retinal detachment. Injection site is visible (arrow). C) Image of retina 4 weeks post-
injection with fused registration grid. D-E, images of mouse 9OS. D) En face OCT image of retina 4 weeks post-injection showing extend of
subretinal detachment. E) Overlay of fundus (green) and en face OCT images of retina 10 min post-injection. Scale bar = 100 µm. Please click
here to view a larger version of this figure.
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Figure 3. Subretinal Injections Cause Temporary Retinal Detachments with Minimal Retinal Thinning. Representative OCT B-Scans at the
site of maximal retinal detachment are shown for pre-injection, 10 min post-injection and 4 weeks post-injection. A) Formation and resolution of
a flat bleb from a 0.3 µl injection. B) Formation and resolution of a domed bleb from a 0.5 µl injection. C) Formation and resolution of a domed
bleb from a 1.0 µl injection. D) Example of severe choroidal scarring and retinal thinning at injection site. Scale bar = 100 µm. Please click here
to view a larger version of this figure.

 

Figure 4. Retinas Retain Normal Function After Bleb Resolution. Waveforms for scotopic rod-mediated responses are shown for pre-
injection (black line) and 4 weeks post-injection (red dashed line) for A) 0.3 µl, B) 0.5 µl and C) 1.0 µl injections at 9 illumination intensities
ranging from 4.37 x 10-6 to 0.51 cd/m2. Please click here to view a larger version of this figure.
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Figure 5. 3D reconstruction of blebs. A) Software-generated 3D reconstructions of representative A) domed and B, C) flat blebs from 0.3 µl
injections. Ribbing is an artifact of reconstruction software. Artificial boundaries were placed in C to allow reconstruction. Scale bar = 150 µm.
Please click here to view a larger version of this figure.

Discussion

Subretinal injections are the method of choice for the delivery of viral vectors and stem cell-derived therapy for manipulating photoreceptors and
the RPE in both basic research and clinical treatment. In patients, subretinal injections are typically done with an anterior sclerotomy at the pars
plana, a posterior core vitrectomy and penetration of the retina by the needle with direct visualization. As with most vitrectomy procedures, it
is common for cataract formation to occur prematurely unless the eye is already pseudophakic. In mice, subretinal injections are traditionally
done with the sclerotomy anterior to the retina, a method frequently associated with both nicking of the lens, which occupies the majority of the
posterior cavity of the eye, and transretinal penetration that can lead to vitreous entrapment and full retinal detachments. Using a posterior-
approach technique in mice reduces these unwanted consequences and improves the ability to interpret effects of the intended manipulation.

Benefits of the subretinal injection technique reported here include minimal structural or functional effects and reduced collateral damage (e.g.,
clouding from lens nicking, vitreous leaking or inflammation) that allows easier assessment of experimental outcomes and faster recovery times.
This technique requires greater manipulation of the eye to reach the posterior pole but can be completed in approximately 10 - 15 min per eye
with a high success rate as no eyes were rejected from analysis. In the majority of injections, normal retinal structure and function was observed
within 4 weeks. By comparison, previous studies report 5 - 8 weeks for recovery of structure and function or do not report a recovery time6,7.
Consequently, experiments can be completed in less time with fewer animals.

Complications of this subretinal injection technique included scar formation and loss of photoreceptors in approximately 10% of injections,
with only three cases of significant structural and functional deficits. The retina retained normal responses to light with only the largest scar
decreasing function to 80% of photoreceptor response and 77% of inner retinal response compared to pre-injection. Retinal incarcerations might
be reduced with the use of a new needle for every injection, although this was not evaluated in the current study. Alternatively, they may occur
due to negative pressure and thus be unavoidable. Incarcerations are very common in human subretinal injections, however, because of the
large size of the eye, incarcerations represent less damage to the total retina. Consequently, if a therapeutic agent had been injected, 90% of
injected eyes would be available for evaluation of the effects of that intervention.

The variability in retinal thickness measurements before and after subretinal injection reflects the reproducibility of the OCT instrument on mice,
the precision of aligning retinal locations across images, and retinal changes from injection of physiologic saline with low dose fluorescein dye.
These measurements can serve to guide investigators in power calculations for the number of eyes and retinal locations necessary to detect
statistically valid changes as a result of subretinal injections whether or not a therapeutic agent is present. In the 10 cases for which there were
9 grid points in all retinal scans, the variability of the retinal thickness outside of the injection site (5 - 8 points per eye) was 7.2% ± 4.0%, even in
the absence of a toxic or therapeutic agent or a hereditary retinal dystrophy. Such variability is a consideration for setting criteria for comparison
of clinical outcomes using mouse models for subretinal treatments, and strongly suggests that appropriate controls include subretinal injection of
vehicle rather than an uninjected eye3. Lastly, we encourage investigators to do numerous OCT scans of multiple retinal regions prior to injection
to improve coverage of the injection site in all scans.

Therapeutic efficacy will likely be achieved when experimental agents are delivered to a greater expanse of the retina. In these cases, larger
volumes are ideal but may not be necessary as 0.3 µl injections often formed flat blebs that covered a large retinal surface area. The bleb
shape was not controllable, although larger injection volumes produced more domed blebs. Up to 1 µl can be injected without negative
outcomes, however, it is possible that domed blebs become so extended that the retina touches and adheres to the posterior capsule of the lens,
particularly in young mice with low vitreous volumes. Despite the volume delivered from the syringe, the actual volume targeted to the subretinal
space is calculated to be less. This may reflect volume that is not acquired in the OCT scans, particularly for domed or flat blebs, or an artifact of
the OCT scan and subsequent reconstruction, but may reflect volume loss from backflow upon withdrawal of the needle.

In summary, using a posterior approach for subretinal injections has fewer complications and improved recovery, resulting in a high success rate
of targeting and low rate of exclusion. This technique is ideal for viral, pharmacological, and cellular manipulations of rodent retinas.
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